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INTRODUCTION

Welcome to Mastercam 2017! Mastercam 2017 features new functionality focused
on delivering speed and efficiency to your machining jobs. We are sure that you
will benefit from what Mastercam 2017 has to offer you and your shop.

New Mastercam Look and Feel
Mastercam 2017 features a new ribbon interface, similar to the Microsoft Office
products. The new interface capitalizes on your experience with other software,
and uses that familiarity to make it easier to find the functions you need to com-
plete your tasks.

The ribbon tabs group similar functions and display them in order from simple to
more complex. Each tab relates to a type of activity, from creating wireframe geo-
metry to generating toolpaths. Editing functions are on the same tab as creation
functions, so you have all the tools you need when you need them.

The tabs also combine icons with text, making it easier to find the functions you
need.

TheMachine tab includes all of your machine types. Selecting a machine type dis-
plays a contextual tab that lists available toolpaths and related functions.
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You can search through toolpath galleries that show icons with sample tool
motion to help you decide which toolpath to use.
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Click File to access the Backstage view, which contains all of your file man-
agement tools. You can access information about your current part file, customize
your Mastercam environment, learn more about Mastercam with the Help and
tutorials, and connect with the Mastercam community.

The Quick Access Toolbar contains a set of commands independent of the tab
that is currently displayed. You can move the Quick Access Toolbar above or
below the ribbon, and you can add or remove buttons as needed.
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You can also right-click on a function in any of the tabs and add it to the Quick
Access Toolbar by selecting Add to Quick Access Toolbar.

Right-click in the graphics window for easy access to all your entity attributes
with the new mini-toolbar. Select the popout button on the right side of the mini-
toobar to anchor the toolbar permanently on the screen.

What's New in Mastercam 2017 — Introduction
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In addition, all of the selection functions are featured in the graphics window so
you can access them when you need to.

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of
your Mastercam 2017 installation:

l What's New in Mastercam 2017

l Mastercam 2017 Installation Guide

l Mastercam 2017 Administrator Guide

What's New in Mastercam 2017 — Introduction



l Mastercam 2017 Transition Guide

l Mastercam 2017 Quick Reference Card

l Mastercam 2017 ReadMe

Contact Us

For questions about this or other Mastercam documentation, contact the Tech-
nical Documentation department by email at techdocs@mastercam.com.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Help— Access Mastercam Help by selecting Help, Contents
fromMastercam's File tab. Also, most dialog boxes and function panels
feature a Help button that opens Mastercam Help directly to related
information.

l Mastercam Reseller— Your local Mastercam Reseller can help with most
questions about Mastercam.

l Technical Support—CNC Software's Technical Support department (860-
875-5006 or support@mastercam.com) is open Monday through Friday
from 8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—CNC offers a series of tutorials to help registered
users become familiar with basic Mastercam features and functions. The
Mastercam tutorial series is in continual development, with new modules
added as we complete them. Visit our website, or select Help, Tutorials
from the File tab.

l Mastercam University—CNC Software sponsors Mastercam University, an
affordable online learning platform that gives you 24/7 access to
Mastercam training materials. Take advantage of more than 180 videos to
master your skills at your own pace and help prepare yourself for
Mastercam Certification. For more information on Mastercam University,

What's New in Mastercam 2017 — Introduction
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please contact your Authorized Mastercam Reseller, visit www.-
mastercamu.com, or email training@mastercam.com.

l Online communities—You can find a wealth of information including
many videos, at www.mastercam.com. For tech tips and the latest
Mastercam news, follow us on Facebook
(www.facebook.com/mastercam), Twitter (www.twitter.com/mastercam),
or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to
see Mastercam in action (www.youtube.com/user/MastercamCadCam)!

Registered users can search for information or ask questions on the Mastercam
Web forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com. To register, select Community, Link onMastercam.com
from the File tab.

What's New in Mastercam 2017 — Introduction
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GENERAL ENHANCEMENTS

Analyze Enhancements

Analyze Trimmed Spline

Mastercam will now inform you if the selected spline is trimmed or not when
using the Analyze Entity function, located on theHome tab.
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Analyze Dynamic Enhancements

The user interface for Analyze Dynamic has been improved for Mastercam 2017.

1. Diameter readout: Displays the diameter of an arc, face, or surface, making
it easier for you to choose a maximum tool diameter for a curved area.

2. Color and RGB information: Displays the color and RGB information of the
selected entity. This information can be used to communicate control tol-
erances and stock to leave.

What's New in Mastercam 2017 — General Enhancements
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3. Arrow scale factor: To assist with debugging, you can now resize the
dynamic arrow by applying a scale factor to it. The size of the default and res-
caled arrows remain consistent even when you change the view scale of the
graphics window. Scaling has replaced Vector information that was in pre-
vious versions of Analyze Dynamic.

Appearance Enhancements

Dimmed and No Hidden Wireframe View

Dimmed and No Hidden Wireframe views now support solids, surfaces, and STL
parts as shown in the following examples.

DimmedWireframe (Surfaces) DimmedWireframe (Solids)

No HiddenWireframe (Surfaces) No HiddenWireframe (Solids)
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Outline Shaded Support for Polygon Mesh/STL

The Outline Shaded effect can now be applied to polygon mesh entities, such as
STL files, which improves the appearance of details.

Shaded Outline Shaded

You can also control this affect by using the Show STL edges option that has
been added to the System Configuration - Shading page. When enabled, STL
edges display in the Outline Shaded view; when the option is disabled, STL edges
do not display. This option is enabled by default.

The Edge angle tolerance option becomes available when the Show STL edges
option is enabled. This value determines what is considered an edge on the STL
entity.

What's New in Mastercam 2017 — General Enhancements
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Rendered Modes

You can now view your solid and surface models as if they wereMetallic, Plastic,
or Glossy. Select one of these options on the View tab to change your part's
appearance.

Default Metallic

Plastic Glossy
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Solid Edges in No Hidden Wireframe Mode

In previous Mastercam versions, you could select hidden edges when in No Hid-
den Wireframe view mode.

In Mastercam 2017, you can no longer select hidden edges when in this mode.
When working in Translucent mode, the edges will show and will be selectable.

ATP Enhancements

Chain Sorting

You can now sort chains based on their area, length, or creation order. You can
then sort them by either Ascending or Descending order.

What's New in Mastercam 2017 — General Enhancements
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Z Position

Use the Translate top of part to Z zero option to move the top of the geometry
to Z = 0.

Automatic Support for GDT Data

Unigraphics/NX and STEP Files

Mastercam 2017 now supports saved views and 3D annotation data in imported
Unigraphics/NX and STEP files. You no longer need to select the Import GDT
data option to import annotated data from Unigraphics files. Mastercam auto-
matically imports any saved views into Mastercam named planes.
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CATIA Version 5

Support for saved views and annotation data requires the CATIA Version 5 trans-
lator with PMI license.

What's New in Mastercam 2017 — General Enhancements
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Code Expert Enhancements

Individual Fonts and Colors in NC Configuration

Fonts and colors can now be set for individual components within your NC Con-
figuration.
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Right-click and select the NC Configuration to apply it to a specific NC file. The
Comments are now blue and bold as shown below.

Tool Change Indicator

TheMark option has been added to the Tools group of theNC Functions tab
when an NC file is open in Code Expert.

What's New in Mastercam 2017 — General Enhancements
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Select this option to add an indicator to the margin of the NC file where tool
changes appear as defined in the NC Configuration.
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Character Encoding to Opened and Saved Text Based Files

Non-English Mastercam users can now set default encoding to use in Code Expert
when opening text files:

A new option has also been added to theHome tab, allowing you to reopen the
current file using a specified encoding.

What's New in Mastercam 2017 — General Enhancements
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By clicking ReloadWith Encoding, the Select Character Encoding dialog displays,
and you can choose a different character encoding.

Character Encoding also allows for proper character display:

Mastercam X9

What's New in Mastercam 2017 — General Enhancements



Mastercam 2017

Improve Communications Options for CIMCO

In previous versions, users that communicate with their machines via CIMCO DNC
through Code Expert were forced to set communications settings in the System
Configurations dialog box. In Mastercam 2017, this process has been simplified by
allowing access to the CIMCO DNC settings directly from the Code Expert inter-
face. The settings are easily accessible by clicking the dialog box launcher in the
Communications group in theNC Functions tab.

General Toolpath Enhancements

Drag and Drop Operations Import

You can now drag and drop operation files directly into the Toolpaths Manager.
When a supported operations file is dropped onto the Toolpaths Manager, the
Import Toolpath Operations dialog box displays. The dropped file is automatically
set as the source library.

What's New in Mastercam 2017 — General Enhancements
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Drill Point Selection

Previously, Drill Point Selection only supported wireframe entities. Now, Drill
Point Selection recognizes solid edges when you select the Entities option.

Ghosted Operations Support

Stock Model operations can now process ghosted operations. Select Process
ghosted operations on the Source Operations page of a Stock Model operation
to process them. Deselect this option to ignore ghosted operations.

This option is useful when using Multiaxis Link or transform operations.
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Reverse Chains Order

You can now reverse the order of chains in the Chain Manager dialog box by
selecting Reverse chains order from the right-click menu.

Preventing Changes to Processing Toolpaths

In previous versions, you were allowed to make changes to a toolpath operation
while it was still processing in the Multi-Threading Manager. This could cause
changes not to stick once the processing was finished.

What's New in Mastercam 2017 — General Enhancements
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In Mastercam 2017, a warning displays when you attempt to change the para-
meters, tool(s), geometry, or NCI while an operation is processing.

You can still view the parameters or geometry, but the toolpath dialog box will be
Read-only.
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Toolpath Transform Enhancements

Include WCS

Plane names for Mirror, Rotate, and Translate transform types have been
improved. When creating a transform toolpath by Tool plane, you can now
include the WCS by selecting IncludeWCS in the Type and Methods tab of the
Transform Operation Parameters dialog box.

What's New in Mastercam 2017 — General Enhancements
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Swap Lead in/Lead out Values

When creating a Mirror transform operation, use the Swap lead in/out para-
meters option to swap the lead-in and lead-out values for the resulting toolpaths.
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Graphics Window Enhancements

Axes Display Enhancements

Screen Info Renamed and Enhanced

Screen Info [F9] has been renamed to Show Axes. The Show Axes function loc-
ated on the View tab controls the display of World, WCS, Tplane, and Cplane axes
separately.

What's New in Mastercam 2017 — General Enhancements
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WCS T/Cplane Axes Renamed and Enhanced

The WCS T/Cplane axes [Alt+F9] command has been renamed to Show Gnomons.
The Show Gnomons function located on the View tab controls the display of
WCS, Tplane, and Cplane gnomons separately.

Interactive Gview Gnomon for Dynamic Planes

Dynamic plane creation can now be triggered by clicking the Gview gnomon as
shown in the following sequence of illustrations. Move the mouse over the static
Gview gnomon until it highlights. Click the origin ball to attach the mouse cursor
and drag your cursor to initiate dynamic plane creation.
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Updated Grid Functions

The grid functions, Active Grid and Visible Grid, previously located on the Grid Set-
tings dialog box have been renamed to Snap to Grid and Show Grid. These func-
tions are now available on the View tab.

What's New in Mastercam 2017 — General Enhancements
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Levels Manager Enhancements

The Levels Manager is now a dockable, floatable function panel and has been
redesigned for more intuitive controls and easier workflow. The toolbar across the
top of the Levels Manger includes the following functionality:

l Add a New Level

l Find a Level from Geometry

What's New in Mastercam 2017 — General Enhancements



l Turn All Levels On/Off

l Reset All Levels

l Display Options

l Hide properties

Column Reordering

You can reorder the columns in the Levels Manager by dragging the column head-
ing. Column order is maintained from session to session.

What's New in Mastercam 2017 — General Enhancements
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Hide or Display Columns

You can hide columns in the Levels Manager by right-clicking a column header
and selecting a column. The Number column is always displayed.

Hide Level Properties

You can now hide the controls below the grid, such as Number, Name, and Level
set. Use this control to maximize the space allotted to the grid, minimize the space
used by the managers, or to stack the Levels and Planes Managers on top of one
another. Click the button again to show the controls.
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Mastercam Add-On Enhancements

STL Heal C-Hook

You can now enter a negative offset distance (and apply an inward offset),
instead of only a positive offset distance.

Support for OnShape Documents

Mastercam has partnered with Onshape; a new, full-cloud 3D CAD system, and
has developed Onshape Connect. Running from within Mastercam, Onshape Con-
nect allows you to download Onshape elements from the cloud to your local or
network drive. Supported file types, including Onshape Part Studios, can be impor-
ted directly into Mastercam.

What's New in Mastercam 2017 — General Enhancements

44



45

Note: Onshape Connect is available from the Onshape App Store
(https://appstore.onshape.com). You must have an Onshape account to use
Onshape Connect. For more information, please visit www.onshape.com.

What's New in Mastercam 2017 — General Enhancements
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Mastercam File Extensions
For Mastercam 2017, the following file extensions have been changed:

Mastercam X9 Mastercam 2017

.mcx-9 .mcam

.emcx-9 .emcam

.operations-9 .mcam-operations

.defaults-9 .mcam-defaults

.mmd-9 .mcam-mmd

.lmd-9 .mcam-lmd

.rmd-9 .mcam-rmd

.wmd-9 .mcam-wmd

.gmd-9 .mcam-gmd

.control-9 .mcam-control

.materials-9 .mcam-materials

What's New in Mastercam 2017 — General Enhancements
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Mastercam Simulator Enhancements

Auto Start

The Enable Auto Start option has been added to the Options dialog box on the
General page for Mastercam Simulator. When selected, Mastercam Simulator will
immediately begin to play once a sufficient amount of data has been transferred.

What's New in Mastercam 2017 — General Enhancements



Fixture Support Enhancements

Fixture support, which was previously added with Mastercam X9, has been
improved. You can now select a solid, multiple levels, or browse for a file to be
used as a fixture.

Printing

You can now directly print fromMastercam Simulator by selecting File, Print. You
will print the current active window view, which is displayed with a red border.

What's New in Mastercam 2017 — General Enhancements
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Record Video

You can now save a video of a backplot or verification session fromMastercam
Simulator in a common format (.mp4) that can be viewed by anyone with or
without Mastercam on their machines.

Click Record in theHome tab to begin recording a video. Once you have fin-
ished, click Record again to stop recording. You then save the recording and you
can distribute as needed.

Reverse Direction for Clipping Planes

You can now reverse the direction of clipping planes when using them in
Mastercam Simulator.

Synchronize Views

You can now link your view in Mastercam to your view in Mastercam Simulator so
if you rotate your part in one, the other will update. You can turn this option on
or off in the View tab of Mastercam Simulator.

What's New in Mastercam 2017 — General Enhancements



Printing Multiple Copies
You can now print multiple copies using the Copies option, located on the File,
Print page.

What's New in Mastercam 2017 — General Enhancements
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Migration of Custom Machine Simulation Files
The Migration Wizard now supports the migration of custommachine simulation
files. TheMachine simulation option has been added to the wizard and includes
the STL, GIF, and BMP files that create the machine model.

Multiple Instances Now Supported
When opening an additional instance of Mastercam, you no longer get the warn-
ing shown below. You can now open additional instances of Mastercam without
instability or data loss.
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Planes Manager Enhancements

The Planes Manager is now a dockable, floatable function panel and has been
redesigned for more intuitive controls and easier workflow. The toolbar across the
top of the Planes Manager includes the following functionality:

l Create a new plane (from Geometry, Solid Face, Gview, Line Normal, Rel-
ative to WCS, and Dynamic)

l Select a lathe plane (radius X/Z or diameter/Z coordinates)

What's New in Mastercam 2017 — General Enhancements
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l Find a plane (From Geometry, Plane, or Relative to WCS)

l Set/Reset your current WCS, construction plane, and tool plane with ori-
gins

l Display Options

l Follow rules

l Hide properties

Always Display Gnomon

In previous versions of Mastercam, the gnomon for the active plane was only dis-
played when the Planes Manager had focus. Now, you can set the gnomon for
the active plane to always display.

Hide or Display Columns

You can hide or display columns in the Planes Manager by right-clicking a
column header and selecting a column.

What's New in Mastercam 2017 — General Enhancements



Hide Planes Properties

You can now hide the controls below the grid, such asWork offset, Color, and
Comment. Use this control to maximize the space allotted to the grid, minimize
the space used by the managers, or to stack the Levels and Planes Managers on
top of one another. Click the button again to show the controls.

New G Column to Set Gview in Planes Manager

A column has been added to the Planes Manager. Click in the G column to
change the Gview to that plane.

New Follow Rule

A follow rule has been added, Tplane follows Cplane. The follow rule is selected
by default, but the state persists from session to session. With this follow rule
selected, the Tplane will change if the Cplane is changed by the user or as a result
of another follow rule, such as Cplane follows Gview. The Tplane can still be
changed independently from the Cplane.

What's New in Mastercam 2017 — General Enhancements
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Origin Enhancements

Previously, the Planes Manager displayed origin values in view coordinates. Now,
the origin values display in world coordinates. The origin values also display in the
Planes (WCS) page of tree-style toolpaths and the Plane Selection dialog box.

What's New in Mastercam 2017 — General Enhancements



The Origin fields will also display a simplified right-click menu that is more appro-
priate for picking plane origin XYZ points. This applies to any parameter where
you use the right-click menu to set origin values.

Reorder Columns

You can now reorder columns in the Planes Manager by dragging and dropping
the column headers. Column order is maintained from session to session.

What's New in Mastercam 2017 — General Enhancements

56



57

Recent Functions
The Most Recently Used functions toolbar has been renamed to Recent Functions
and is now a dockable, floatable function panel. Recent Functions allows you to
see a history of the Mastercam functions you recently used and quickly reselect
them.
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Setup Sheet Enhancements

New Setup Sheet XML Tags

New XML tags have been added to the setup sheet, such as tool and holder loc-
ation, machine type, machine name, and post processor file name.

Option to Clean Up XML Folder

An option has been added that deletes all XMP and BMP files automatically cre-
ated at run time during your previous setup sheet sessions. Use this to help you
maintain disk space.

After you click the Clean button in the Setup Sheet dialog box, the system informs
you of the number of files about to be deleted and prompts you to accept the
cleanup or not.

This option is only available if you have previously run the setup sheet function.

What's New in Mastercam 2017 — General Enhancements
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Save Images in Nesting Reports
An option has been added to create nesting reports with high resolution images.
Select Higher resolution images in reports in the Nesting Configuration dialog
box to increase the images of sheets and results to a maximum of 2400 pixels and
parts to a maximum of 1200 pixels. The orientation determines whether the max-
imum size will be applied to the length or width.

System Configuration Enhancements

Chaining Arrow Size Options

You can now change the size and translucency of 3D chaining arrows to make
themmore usable when a file has numerous chains in a window (for example,
when chaining text for engraving).
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If arrows in the graphics window overlap or obscure other arrowheads, you can
set the arrow size to Small,Medium, or Large. Change the arrows from opaque to
translucent by selecting the Translucent checkbox. These options are located on
the Chaining page.

Get Defaults from Previous Operation

The Get defaults from previous operation option, located on the Toolpaths
page, allows a newly created operation to pull defaults from the previous oper-
ation of the same type. If no compatible operation is found, the parameters are
pulled from the defaults library. This option is on by default. This functionality
was previously delivered via the PrmDef C-Hook, which has been removed from
the Mastercam installation.

What's New in Mastercam 2017 — General Enhancements
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When disabled, new operation parameters are pulled from the defaults library.

Import Sketch Data from SOLIDWORKS

You now have the ability to import sketch data from a SOLIDWORKS file.

You can automatically include this information by selecting the Import sketches
from SOLIDWORKS files option located on the Converters page of the System
Configuration dialog box.

What's New in Mastercam 2017 — General Enhancements



You can also import this information from SOLIDWORKS files as you open them
by selecting the Import Sketches option from the SOLIDWORKS File Parameters
dialog box. The File Parameters dialog box displays when you select the Options
button on the Open dialog box.

You must have a seat of SOLIDWORKS to import sketch data into Mastercam.

What's New in Mastercam 2017 — General Enhancements
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New View Settings Page

The View Settings page, under the Screen page, has been added to the System
Configuration dialog box. This page contains options that previously resided on
the Screen page.

The Snap to views in dynamic rotation setting has been added. Select this option
to have your part automatically snap to views during dynamic rotation. The
rotated part snaps to a view within the tolerance (in degrees) you set.

Screen Page Enhancements

The Screen page has been updated as follows:

l The Display toolpaths option displays the toolpaths when selected and
hides toolpaths when deselected.

l The Use stipple on solids/surfaces option displays the stipple overlay
effect on auto-highlighted or selected surfaces and removes the stipple
overlay effect when deselected.
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l The Display part information option has been removed in favor of the
new Show Axes toggle on the View tab.

l The Display viewport XYZ axes option has been removed in favor of the
new Show Gnomons toggle on the View tab.

You can also change the size of gnomons, gnomon labels, on-screen text, and the
scale indicator with the Scale display gnomons and text option. Use the Selec-
tion controls opacity slider to adjust the display of the Selection Bar and Quick
Mask controls. These options are especially helpful when using a 4K monitor.
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Set Tool Colors

You can now set colors for different sections of a tool on the Colors page. These
settings control how the tool displays in the Tool Wizard.

Solid Preview Option

You can now turn the auto-preview off or on for all history-based solids. The Set
solid preview on by default option is located on the Solids page.
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Viewsheet Enhancements

Create and Save Bookmarks from Planes

Two options have been added to the Dynamic Plane and New Plane dialog boxes.
Select Create Viewsheet to automatically save a viewsheet with the name of the
plane upon exiting the dialog box. When Create Viewsheet is enabled, the Save
Bookmark option becomes available, which saves a bookmark on the newly cre-
ated viewsheet.
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Delete Multiple Viewsheets

You can now select multiple viewsheets and delete them or their bookmarks. To
do so, hold down the [Ctrl] key while selecting the viewsheets, then right-click
and select Delete Viewsheet or Delete Viewsheet Bookmark from the menu.

Removed the Concept of "Main" Viewsheet

Viewsheets are now less restricted, as there is no longer a "main" viewsheet. You
now have the ability to bookmark any viewsheet and reorganize the order of
viewsheets as needed.

However, you cannot delete the last remaining viewsheet as there must always be
at least one active viewsheet.

Zip2Go Enhancements
The Zip2Go enhancements include the following:

l You can open a Zip2Go (.z2g) file by dragging and dropping the file onto
the graphics window.

l The Configure menu selection has been renamed to Options and is found
in the Filemenu. Selecting Options opens the Options dialog box where
you can alter file and folder settings.

What's New in Mastercam 2017 — General Enhancements



68

What's New in Mastercam 2017 — General Enhancements



69

DESIGN ENHANCEMENTS

Bounding Box Center Point
In addition to creating a point at the center of the bounding box, the Center
point option now creates geometry on each flat face of the bounding box. This
change only applies to rectangular bounding boxes.

On a cylindrical bounding box, the Points option creates a point at the center of
two flat faces of the cylinder and the Center point option creates a point at the
center.
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Drafting Enhancements

Drafting formatting

You can now apply the format of an existing dimension to a new dimension by
pressing the tilde key [~] and selecting the existing dimension text.
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Edit text heights for both notes and dimensions

The Apply to dimensions and notes option has been added to the Height dialog
box, accessed by selecting Height on the Basic tab of the Drafting function panel.
This allows you to change both dimension and note heights at the same time.
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Plane Selection Enhancements
The X, Y, and Z options in the Plane Selection dialog box have been enhanced to
increase functionality, accuracy, and efficiency.

1. Added spin controls.

2. Added Select point button. Use this button to select an AutoCursor position
from the graphics window. The appropriate X, Y, and Z value of that position
will be entered into the corresponding field.

3. Added the Construction depth button. Use this button to copy the current
Z depth value into the X, Y, or Z fields.
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Solids Enhancements

Disassemble Enhancements

The user interface for Disassemble has been improved to better support your
designing practices.

Placement Options

The checkbox for Automatically place bodies has been replaced with three radio
buttons.
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In addition to the Automatic andManual options, you can now place dis-
assembled bodies at the origin of the Layout level. Bodies placed at the origin
through this option can be placed at any level, but the levels can only be incre-
mented by solid bodies and not by thickness.

Undo

Undo is now applied to all solid bodies instead of one solid body at a time.

Viewsheet Support

Select the Create viewsheets for each level checkbox to create a viewsheet for
bodies on each level. The resulting bodies are moved or copied to a new
viewsheet and bookmarked with the new level.

Keep Name After History is Removed

The names of solid bodies are maintained after their history has been removed.

Optimize

Optimize, located under the Simplify Solid drop-down in theModify group of
theModel Prep tab, automatically repairs imported solids (whole bodies or indi-
vidual faces) by improving the accuracy of edges and by identifying and optim-
izing blends. Toolpaths on the repaired solid maintain associativity to faces.

Pick Solid Face Color

You can now obtain a color number during the Change Face or Set Feature func-
tion by clicking the Select button in the Colors dialog box and selecting the solid
face.
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Preprocess Solid

The Surface From Solids function, located on the Surfaces tab, now includes a
Preprocess solid option that can assist in the conversion of solid faces into sur-
faces.

Mastercammakes a copy of the body, prepares it, and then creates surfaces from
this body. After the conversion, Mastercam deletes the preprocessed body, leav-
ing the original intact.

Repair Small Faces

Repair Small Faces analyzes solid bodies (with no history) and reports if it finds
small entities such as spikes, sliver faces, edge pinches, and gashes. If the function
finds these issues, it gives you the option to repair the solid.
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Solid Impression

Solid Impression is a function that automates the creation of an electrode tool
without having to create an extrusion and Boolean operation. Solid Impression
produces a negative impression of a selected closed body.

To create the impression, select a planar wireframe chain. The function then pro-
jects the chain to the solid body. The depth of the projection is from the wire-
frame chain to the lowest face of the selected solid or to a selected face.
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Transform Enhancements

Transform Dynamic AutoCursor Support

Transform Dynamic now supports AutoCursor snapping to horizontal, vertical,
and tangent positions when rotating geometry. These options are only available
when the plane equals the Cplane.

To use these options, select the geometry you wish to transform, then right-click,
and select AutoCursor to open the AutoCursor Settings dialog box. Select Tan-
gent or Horizontal/Vertical to activate the snap options.

Rotate the selected geometry, and it will snap horizontal, vertical, or tangent to
another entity as shown below.
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Snap to tangent

Snap to horizontal
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Snap to vertical

Dynamic Gnomon Editing

The Dynamic Gnomon includes a button that switches between editing the geo-
metry and editing the gnomon positions when using Translate.

Gnomon mode

Geometry mode
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Translating an entity using the Geometry mode:

Editing the gnomon position using Gnomon mode:
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Scale

Scale now includes an Auto center option and a scale calculator.

Auto center moves the center of the scaling function to the center of the selected
geometry. When the option is deselected, the center of scaling returns to the
default (0,0,0).
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The Scale Calculator dialog box calculates a scaling factor. You choose a Base
value and a Result value. The calculator then divides the result by the base to get
the Scale factor.

For example, you can enter a Base of 3.4 and a Result of 5, it automatically cal-
culates the Scale factor of 1.47. You can also select geometry to define your Base
and Result. Select a circle that needs to be scaled to match another circle, and
Mastercam will do the calculations for you.
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Stretch

You can now dynamically stretch geometry with Mastercam's single-axis arrow
control. Window select the entities to transform, then move the individual arrows
in the graphics window to stretch along the X, Y, or Z axis.
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Wireframe Enhancements

User Interface Changes

Most functions that previously used the horizontal ribbon bar have been moved
to a function panel for Mastercam 2017. The interface for these functions has the
same look and feel as the Solids interface, allowing you to work in the function
panel and in the graphics window simultaneously.
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Sharp Corner Smoothing Added to Spline From Curves

The Sharp Corner Smoothing option has been added to the Spline From Curves
function. Sharp corner smoothing blends in a new spline segment based on the
Blend distance.

Break at Points

This function, located on theWireframe tab under Trim Break Extend, allows
you to break geometry at selected points that lie on it.

Point and Line Dynamic Split into Two Functions

The Point and Line Dynamic function have been split into two separate functions,
Point Dynamic and Line Normal.

Use the Point Dynamic function to create points on wireframe entities, surfaces,
and solids. Use the Line Normal function to create lines perpendicular to any exist-
ing surface or solid face.
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Refit Spline

Use this function to remake poorly defined splines that have too many nodes or
sharp corners at nodes. Refit Spline creates a smoother spline with fewer, more
consistently spaced nodes.

Sharp corners are automatically detected and blended for smoother results. You
can adjust the corner angle identified for smoothing by changing the value in the
Detection angle field

Relief Fillet Style

The Relief option has been added to the Fillet Entities function. This allows you to
put clearance on only one entity. This is useful when the outside faces of the
tenon do not hide the current clearance fillet.
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Untrim Spline

Untrim Spline, which was a C-Hook in previous versions of Mastercam, is now a
function on theWireframe tab. Use this function to untrim all selected splines
and NURBS curves to their original extents. Untrim Spline reverses the effect of
earlier trim operations.

Persisting Values for Create Letters

The values that you enter for height and spacing in the Create Letters function will
now persist between sessions.
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TOOL ENHANCEMENTS

Add and Remove Manufacturers and Tool Grades
You can now add manufacturers and tool grades to a library during tool creation
and tool editing from both the Wizard-style dialog boxes and from the property
grid in the stand-alone Tool Manager. Click the green plus button next toMan-
ufacturer name or Tool Grade to add a new name.

What's New in Mastercam 2017 — Tool Enhancements



Expand the drop-down lists forManufacturer name and Tool Grade to select
names that have already been added. Use the buttons to the right of the name to
edit or remove it from the list.

Custom Tool Display
Mastercam offers the ability to define a tool using parametric properties along
with a custom profile that can be imported from a CAD file. The parametric values
are used within the toolpath calculations for improved performance, especially for
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complex milling operations. The optional custom profile, when provided, is used
for stock model generation and collision checking in simulation.

You can now display both profiles for comparison. The default behavior is to
render the custom profile as a 3D shaded tool and overlay the parametric profile
using a dotted line-style.

Render Mastercam Tool Render Imported Tool

To render the parametric tool and overlay the custom profile, select the desired
option shown below.
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High Feed Mill Tool Type
Mastercam now supports the High Feed Mill tool type.

If the parametric definition does not meet your needs, or if the manufacturer
provides profile data in the form of a 2D CAD file, use import option to define a
custom High Feed Mill tool.
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Import 3D STEP File
You can now import STEP models to generate custom tool or holder definitions.
Select the Import and link to custom geometry from a file to select a STEP file
to import.
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NCI Parameter for Tool Assembly Name
The 20020 NCI line now contains the name of the holder and the 20021 NCI line
now contains the name of the assembly. These parameters can be accessed by the
post processor or any other client of the ASCII NCI file, including .SET files.
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Overall Length
The total length of the holder is now displayed in the upper left-hand corner of
the graphics view when creating a holder with the Holder Wizard.
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Similar Tool Warning
You can now choose to no longer display this dialog box when adding similar
tools. This option only applies per Mastercam session.

Thread Pitch
You can now override the thread pitch when working with single point thread
mills for a Thread Mill toolpath.
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On the Cut Parameters page of a Thread Mill toolpath:

l TheNumber of active teeth parameter is disabled if the selected tool is a
thread mill.

l The Thread pitch parameter is disabled if the selected tool is a thread mill
and if theNumber of active teeth is greater than one.

l In all other cases, both fields are enabled.

Tool List Enhancements

Column Display

You can now right-click in the column header on any tool list to hide or display
columns.
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Display Mode Setting

Mastercam now retains your setting for Displaymode in all tool lists that offer the
option of showing Tools, Assemblies, or Both. These settings are saved separately
for each list and will persist between sessions.
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Tool Migration Warning
Mastercam's Classic Tool Manager can open and read older file formats when
selecting tools from a library. However, if you make a change to a library
Mastercam displays a warning that you can no longer open that file in a previous
version of Mastercam.
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Tool Projection
You can now display your tool assembly in the graphics window and make edits
to it. Right-click on a tool in the Classic Mastercam Tool Manager, in the Tool
page of tree-style toolpaths, or the Toolpath parameters tab in tab-style toolpaths
and select Edit projection.
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This allows you to see what the tool assembly will look like against the part you
are machining. You can position it anywhere in the graphics window by clicking
the projection and then clicking where you would like to place it.
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To edit the assembly, simply select the assembly and then either enter a value or
use the ruler to drag it up or down to a specified length.

In the Planes Manager, you can also change the Tplane and the tool will change
accordingly.
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MILL ENHANCEMENTS

2D Enhancements

Dynamic Mill Line of Sight

Micro lifts in the Dynamic Mill toolpath now use a line-of-sight approach to move
the tool where it needs to go through unobstructed areas. Listed below are some
of the improvements made through these changes:

l Results in reposition moves during micro lifting that are more efficient,
less complex, and travel a shorter distance

l Creates less motion, which creates smaller NC file sizes

l Improves the cycle times at the machine

Mastercam X9 Mastercam 2017
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Modeless Chain Options and Chaining Dialog Box

While the Chain Options or Chaining dialog box is open, you can manipulate the
graphics window view while selecting your chains.

Region Chaining Preview

You can now preview your machining regions, air regions, and containment
regions for Dynamic Mill and Area Mill toolpaths. After selecting your chains,
click the Preview chains button to view them in the graphics window.

You can also change the color of the display chains to help you identify which is
an air region, a machining region, and a containment region. These colors can be
changed in the Colors page of the System Configuration dialog box or through
the Colors button on the Chain Options dialog box.

Toolpath Preview

You can now preview the following 2D High Speed toolpaths in the graphics win-
dow before closing and generating or regenerating the toolpath.

l Dynamic Mill

l Area Mill

l Dynamic Contour
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l Peel Mill

l Blend Mill

Click the Preview button in the top left corner to enable or disable the preview.
You must have a tool assigned to the toolpath or the preview will not display.

3D Enhancements

Maximum Stock Engagement

TheMaximum Stock Engagement option on the Stock page for 3D HST Finishing
toolpaths (with the exception of Horizontal Area and Pencil toolpaths) allows you
to select a previously made stock model and set the maximum depth so that you
can limit how deeply the cutter engages uncut material. This is particularly useful
when semi-finishing a part.
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Optimized Raster Motion

The Perpendicular fill option on the Cut Parameters page for HST Raster allows
you to limit raster passes relative to a cutoff distance of 1.4 times the Stepover,
and then fills in the limited area with perpendicular raster motion to create a clean
result.

Perpendicular fill off Perpendicular fill on
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Scallop Processing Time

The processing time for 3D HST Scallop has been decreased to allow for quicker
toolpath regeneration.

Trim to Stock/Rest Material Page Changes

In an effort to consolidate, the Trim to Stock and Rest Material pages have been
renamed to Stock and moved higher up in the toolpath tree display.

In addition, the Stock to leave onWalls and Floors options have been removed
from the Cut Parameters page and placed on their own page, called Stock to
leave, located under the Stock page.
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Multiaxis Enhancements

Angle Step Value

You can now specify the Angle Step value on the Safety Zone page, which was
previously always set to 2 degrees.

Multiaxis Drill

Multiaxis Drill has some new features, including:

l Using a line length for the drill depth.

l Association to selected geometry, removing the need for the geometry to
be visible.

l Recognition of the stock model for depth and top of stock purposes.

l Selection of holes in solids using hole-axis functionality.

l Linking values relative to selected points, lines, or holes.
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Interface Changes and Toolpath Consolidation

The Multiaxis toolpaths have been consolidated to reduce confusion and the over-
whelming amount of toolpath options available. The following toolpaths have
been consolidated or have been renamed:

Mastercam X9 Mastercam 2017

Morph between 2 curves
Morph

Morph between 2 surfaces

Parallel to multiple curves

ParallelParallel to surfaces

Parallel cuts

Cuts Along Curve Along Curve

MSurf MultiSurface

The following toolpaths have been removed:

l Cavity Tilt Curve

l Cavity collision control Curve

l Projection

l Impeller Blade Swarf Finishing

l Impeller Floor Surface

l Impeller Floor Surface without Tilt Curve

l Blade root machining

l Electrode machining 4+1 Axis

The toolpaths are now grouped by either a Pattern or Application toolpath type.
Pattern toolpaths are general toolpaths that can be used in a variety of ways to
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manufacture your part. Application toolpaths are designed to solve particular
machining problems while automating some of the processes.

Mastercam X9
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Point and Line Associativity

Point and lines selected for tool axis control will now be associated with the
toolpaths in which they are used. The Point, Line, and Advanced Options sub-
branches have been removed when selecting these entities.

Point Sorting

Point sorting is now available for Multiaxis Drill and Circle Mill toolpaths. Select
Sorting from the Drill Point Selection dialog box to access the sorting controls.
You may also change the sorting options through the toolpath's parameters. The
same sorting options used in 2D/3D toolpaths are now available in select Mul-
tiaxis toolpaths.
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Roughing Page Consolidation

The Roughing page has been condensed so all common options are available on
a single page. Depth cuts, multi passes, morph pocket, and sorting can now be
found on the Roughing page.

Rotary Advanced

Mastercam's Multiaxis package now includes a new 4-axis toolpath - Rotary
Advanced. This powerful toolpath allows more control over the tool motion
through the selection of walls, hubs, and shroud surfaces. Define your stock,
select your part geometry, set collision control options, and adjust linking moves
to quickly create motion on complex parts. Rough or Finish your rotary 4-axis
using Rotary Advanced.
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Stock Page Consolidation

The various ways of selecting stock have been updated to have consistent work-
flow and selection methods. The Trim to Stock, Rest Material, and Stock definition
pages have been renamed to the Stock page. An icon now displays if Stock is
turned on or off, similar to 3-axis toolpaths.

In the Stock page, you can now select the Job Setup option to use stock already
defined in the Machine Group Properties dialog box.
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LATHE ENHANCEMENTS

Align Solid Body (Lathe)
This function has been added to Lathe which simplifies the process of aligning
solid models for turning. It has also been added to Mill-Turn ("Align Solid Body
(Mill-Turn)" on page 121).

You define the center of the rotation for the part and select the appropriate geo-
metry. Mastercam will then rotate to an Isometric view, where you can use the
dynamic gnomon to adjust the origin.

You can then create a WCS, leaving the part where it exists in space, or you can
transform the part to a plane you select.
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This function is found on the Lathe Turning contextual tab, shown below.

Chip Break
A new option and dialog box has been added to the Lathe Rough and Lathe Con-
tour Rough toolpaths to establish when chip breaks occur. It is located on the
Rough parameters and Contour rough parameters tabs, respectively. Select the
checkbox and click Chip Break to open the dialog box.
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This is valuable when working with stringy materials, such as aluminum or plastic,
and allows you to set length and time conditions, retract, and dwell options.

Chip Break Off

Chip Break On
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Lathe Plane Enhancements
The process of selecting the tool plane, origin, and display mode has been sim-
plified in Lathe operations. The Coordinates button, which appeared on the
Toolpath parameters tab, has been removed and all functionality has been moved
to the Axis Combination/Spindle Origin dialog box.
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The new Axis Combination / Spindle Origin dialog box filters available tool planes,
displaying only those planes with the correct orientation for the selected axis com-
bination.
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You can also right-click in the Spindle Origin list to create a new tool plane or
rename a tool plane.

Display Mode

Mastercam includes Lathe construction planes that let you work in radius or dia-
meter coordinates. The construction plane affects the drawing mode for geometry
creation. The construction plane also affects the display mode, altering the input
fields for items such as Home Position and Reference Points.

An option has been added to the Axis Combination / Spindle Origin dialog box,
which allows you to quickly and easily determine if data should be entered dia-
metrically or radially when a given plane is used in an operation.
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The active construction plane is used to determine the default setting for the Dis-
play Mode when the first Lathe toolpath is created. If the plane is set to one of the
diametric Lathe planes, the setting in the Axis Combination / Spindle Origin dia-
log box will match.

Previous Mastercam version files will retain the settings used in the respective
planes used in lathe operations. This can then be used to modify the Display
Mode.

Lathe Stock Model Enhancements
Lathe Stock Model operations now allow you to manipulate the Lathe stock
boundary using Mill operations.

The Lathe operation option allows you to select a previous Lathe operation as the
source of the stock shape by reading the stock boundary contained in it.

The Create stock boundary option lets you create a new Lathe stock boundary
using the spun profile of the stock model.
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TNRC Control for B-Axis Turning Operations
The Tool Angle dialog box contains new options, which were previously only avail-
able for Mill-Turn operations. Select the Tool Angle button on the Toolpath para-
meters page to open this dialog box.

These options tell Mastercam which quadrant you used to touch off your tool. If
you are creating a toolpath and the tool's control point is not where you want,
you can use these options to swap it. Select theManually define the cutting dir-
ection checkbox and choose the option that matches how the tool was touched
off on the machine.
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MILL-TURN ENHANCEMENTS

Align Solid Body (Mill-Turn)
The Align Solid Body function, which was added for Lathe ("Align Solid Body
(Lathe)" on page 113), is also available for Mill-Turn. This function has been
added as part of the Job Setup process, simplifying the setting of the WCS when
off-axis work pieces are encountered.

This function also appears on theMill-Turn Turning contextual tab, allowing for
the manipulation of other solids following the Job Setup process.
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Application Guides in .machine Files
Every Mill-Turn machine solution includes a comprehensive application guide
which documents machine-specific information on setting up tools, token set-
tings, and other valuable information. The application guides are provided in PDF
format and are part of the .machine file.

SelectMachine Application Guide on theHome tab in Code Expert to launch an
application guide specific to your current machine.

Job Setup Enhancements

Improved Handling of Position Changes

Changes to values such as Part Stickout, Pickoff Position, or Jaw Dimensions no
longer result in associated geometry being deleted and recreated. All geometry
associated with Job Setup and operations in the Machine Group will now be
moved to their new location when the operations are regenerated.

Improved Handling of Complex Part Geometry

Job Setup now uses a process similar to Transform, where the selected part geo-
metry and turn profile are created when the Job Setup process is completed.
While it is processing, Job Setup uses a wireframe representation. This results in
improved performance.
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Machine File Version Properties
We have added version information into Mill-Turn machine files (set by machine
developers). This information is now accessible through the File properties in Win-
dows.

Multi-Sessions and Multi-Machine Group Support
MastercamMill-Turn now supports multiple sessions and multiple Machine
Groups. Each Mill-Turn Machine Group will be matched with a unique session of
Code Expert and Simulation.
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Multi-Station Tool Locators for Turrets
Mill-Turn now supports multi-station tool locators for turrets, as well as half index
positions. Tool locator positions are set in the turret setup which has been
redesigned. Enter information for index positions, mounting locations, and sev-
eral other options, including if half index locations exist.
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The tool locator components are now able to be mounted on available attach-
ment positions. Options are available to define individual stations within the tool
locator. A field for projection adjustment is also provided.
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The Tool Setup Manager has been redesigned to improve workflow and ease of
use:

l The Filter group streamlines the items listed, reducing clutter.

l Tooltips have been added to the tool locator components, providing easy
access to information.

l Edit a tool within the Tool Setup Manager by selecting Edit Tool from the
right-click menu.

l Mountable index positions have been added to the Machine tooling
setup, representing available locators and stations where tools can be
loaded. Use the Remove and reload all tools button to do this for you
automatically.
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l Drag and drop loaded tools between stations, allowing for quick and easy
location changes.

l Use the right-click menu in the display list to view the components in the
graphics view.

Tool Setup Manager communicates directly to Machine Simulator, allowing you
to see your tool locators, stations, and mounted tools.
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Reference Positions Enhancements

Allow Multiple Reference Return Locations

MastercamMill-Turn now supports multiple reference return locations for
machines such as the Okuma Multus, which allow the user to utilize up to eight
different reference return locations. When multiple reference return locations are
available, one can be selected as the default for use in each stream of output. We
have also added the ability to define a string for output in the NC code, allowing
for localization for the reference position name without changing the output in
the NC file.

Add Optional Default Reference Position in POCO

MastercamMill-Turn Pickoff and Cutoff (POCO) processes now support default
reference positions for use in the transfer process. This functionality is useful for
machines where the default reference return location may not be usable once the
pickoff spindle has been moved, allowing safe positions to be defined and used
for turret tool changes.

View Control Options for Sync Manager
Sync Manager View options in the right-click menu have been expanded to sup-
port ZoomWindow, Unzoom 80%, and Dynamic Rotation.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT FOR

THE LATEST DOWNLOADS.

http://i.youku.com/Mastercam
https://www.instagram.com/mastercamcadcam/
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